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Introduction 

This document explains how to localize the Ensim® Pro for Windows® control panel and online Help 
for any language or region. 

Important: The instructions provided in this document are applicable only to Ensim Pro 
4.0 for Windows 2003 and later. 

For languages and directory names that map to each language, see the language and directory 
names table ("Languages and directory names" on page 12). Please review the list and replace all 
instances of <language_directory> in this document with the corresponding directory name values 
from the Directoy name column. 

Important: Ensim Pro for Windows does not support International Domain Names 
(IDN). It also does not provide support for Microsoft® Windows 95, Windows 
98, and Windows ME client tools localized to double-byte character sets. 

Note: For simplicity, we will refer to Ensim Pro for Windows as "Ensim Pro" throughout 
this document. 
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Translation kit contents 

The translation kit for Ensim Pro consists of four components. The following table lists these 
components. 

Ensim Pro for Windows 2003 Localization 
Guidelines
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Table 1.  Translation kit contents 

Component Description 

epw_localization_guidelines.pdf This document. 

epw_source_strings.zip Source strings in text file format. 

epw_services_xml.zip XML mapping for service components.

epw_help_source.zip containing zip files for the 
following: 

• General Help 

• DNS Help 

• Windows Web Hosting Help 

Help source files in RoboHelp format. 

 
 

Localizing the text string files 

The text strings are provided in the epw_source_strings.zip file. You will need to use the WinZip® 
utility to decompress and open the zip file and extract the files within, then use a text editor such as 
Notepad to translate the text strings. 

The following files are packaged in the zip file: 

• COLDFUSION.strings.po 

• DNS.strings.po 

• MAIL.strings.po 

• platform.strings.po 

• URCHIN4.strings.po 

• WVH.strings.po 

• wwp.DNS.strings.po 

• wwp.MAIL.strings.po 

• wwp.platform.strings.po 

• wwp.URCHIN4.strings.po 

• wwp.WVH.strings.po 

To localize the strings and offer a new language in the Ensim Pro control panel, you need to 
translate the strings, then install the translated strings on the Ensim Pro server. 

The text strings used in the Ensim Pro control panel are stored in text files as key-value sets. The 
key represents the unique identifier for the message string (msgid) and the value (msgstr) 
represents the actual message string displayed to the user. 

The following is a sample entry from a localized (French) file. 

 
msgid "MSGID_254" 
msgstr "Nouveau nom de l'organisation" 
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where: 

 The msgid line includes the message identifier. 

 The msgstr line includes the actual message string (the French version of the source English 
string). 

 

Special guidelines for localizing the text string files 

When modifying the text files, follow these guidelines. 

• Only modify the actual message string in the msgstr line. 

• Do not modify the identifier in the msgid line. 

• Do not translate API (application programming interface) calls or classes. These appear as 
compound words, such as GetFromDB, QuotaGroups, QuotaTypes, and ContainedType; they 
are used by the API, which is not translated. 

• Do save the translated files with the correct Unicode encoding. 

Use UTF8Encoding (UTF8) for all Latin character sets (for example, Dutch, English, French, 
German, Portuguese, and Spanish) and UTF16Encoding (UTF16) for all non-Latin character sets 
(for example, Japanese). 

 

Installing the translated text string files 

After you have translated the files, you can install them on the Ensim Pro server. This enables you to 
view the translated strings when you log on to the control panel. 

 To install the translated files: 

1 Remotely login to the Ensim Pro server using Remote Desktop  
(How to article: 
http://www.microsoft.com/windowsxp/pro/using/howto/gomobile/remotedesktop/default.asp). 

2 Transfer the translated files onto the Ensim Pro server. 

3 Create a directory with the name <language_directory> in the following locations: 

 C:\Program Files\Ensim\WEBppliance\cp\admin\resources\<language_directory> 

 C:\Program 
Files\Ensim\WEBppliance\cp\admin\siteadmin\serviceComponents\filemanager\FM
Web\<language_directory> 

Note: <language_directory> is a special name used to map directory names to available 
languages. For the complete list of languages and corresponding directory names, 
see the language directory name table ("Languages and directory names" on page 
12). To get the list of supported languages, type the command reglangpack -l on 
the Ensim Pro server. 

4 Copy all the translated files to C:\Program 
Files\Ensim\WEBppliance\cp\admin\resources\<language_directory>. 

5 If there is an older version of a file, the new version should replace it. From the DOS shell, do 
the following: 
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a Change directory (cd) to  
C:\Program Files\Ensim\WEBppliance\cp\admin\resources. 

b Type the following commands. 

net stop w3svc 

reglangpack –s <epserver> 

where <epserver> is the name or IP address of the Ensim Pro server. 

net start w3svc 

6 Change directory (cd) to C:\Program 
Files\Ensim\WEBppliance\cp\admin\siteadmin\serviceComponents\filemanager\FMWe
b\resources and repeat step b in the preceding step. 

The translated files are installed and you will be able to view the translated strings when you 
log on to the control panel. 

 

Localizing the online Help files 

The Ensim Pro online Help files are provided in a zip file with Ensim Pro. You will need to use the 
WinZip® utility to open the zip archive and extract the files. The zip archive includes three zip files 
for the General Help, DNS Help, and Windows Web Hosting Help projects. Use the WinZip utility 
to extract the Help files from each of these zip files, then use Adobe® RoboHelp X5 to open each 
Help project. 

Important: RoboHelp X5 currently supports 11 international languages: English, Danish, 
Dutch, French, German, Italian, Norwegian, Brazilian Portuguese, 
European Portuguese, Spanish, and Swedish. 
 
If you want to translate the Help files to a language not listed above, contact 
Adobe Support at http://www.adobe.com for additional guidelines on the 
translation. 

The Ensim Pro online Help system is created from the following RoboHelp X5 projects: 

• General Help.xpj 

• DNS Help.xpj 

• Windows Web Hosting Help.xpj 

From each of these RoboHelp projects, HTML Help systems (WebHelp) are generated for the service 
provider, reseller, organization, and user control panels. The output is generated in English. If you 
want to use only the English version as is, you do not have to do anything. The English versions of 
these Help systems are included with the Ensim Pro software. 

However, to view the Help system in languages other than English, you must translate the Help 
content into the language of choice, create additional directories, then copy the translated files to the 
directories. 

For example, if you want to view the Help system in Canadian French—French (Canada) with the 
language directory fr-CA—you must first translate the Help source files into Canadian French using 
RoboHelp, then generate the output for all four levels. 

Next, you must then create the fr-CA subdirectory under each of the following four directories: 
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• Ispadmin 

• Resadmin 

• Siteadmin 

• Useradmin 

Finally, you must then copy the translated French Help files under that subdirectory for each level 
(for example, at the service provider level, you will copy all the Help files into the same fr-CA 
directory). 

If you want one more language Help installed, for example, Mexican Spanish—Spanish (Mexico) 
with the language directory es-MX—you have to just repeat the process, that is, translate the Help 
source into Mexican Spanish using RoboHelp, create the es-MX directory under each of the four 
directories mentioned above, then copy the translated Help into the  
es-MX subdirectories. 

When you log on to the Ensim Pro control panel, you can select your language preference. If you 
select us-English, Ensim Pro automatically picks up the default Help. If you select anything else, for 
example, French-Canada, Ensim Pro links to the fr-CA subdirectory for that level when a Help link 
is clicked. 

To localize the online Help, you need to complete the following tasks, which are detailed in this 
section: 

1 Translate each project, being careful not to modify conditional text, bookmarks, and comments. 

2 Generate the required output. 

3 Install the output on the Ensim Pro server. 
 

Special guidelines for localizing the General Help 

The general Help for the ISP, reseller, organization, and user control panels is generated from a 
single project file: General Help.xpj. Conditional text is used to generate the output for each level. 

Caution: Be careful not to change or remove bookmarks and comments; without them, 
you cannot install the Help on the Ensim Pro system. 

Before you begin working on the project, make sure you understand how to identify conditional 
text, bookmarks, and comments so that you avoid changing or removing them. 

 

Identifying bookmarks and comments in the General Help 

When you work on the project in RoboHelp’s WYSIWIG editor, it’s a good idea to work in the view 
that shows conditions, bookmarks, and comments. In this view, special icons are displayed where 
bookmarks and comments appear. 

If bookmarks and comments are hidden, the WYSIWYG editor shows nothing more than an extra 
line space where the bookmarks and comments appear; if you backspace near this line, you can 
delete the tags inadvertently. Without tags, the online Help may not display properly. 

Note: The bookmarks and comments used for service-specific links are always preceded 
by the following text: For more information, click the links below to 
open the service-specific Help. 
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 To show bookmarks and comments: 

1 On the View menu, select Show, then click Bookmarks. 

2 On the View menu, select Show, then click Comments. 

3 On the View menu, select Show, then click Conditional Areas. 
 

Translating the online Help files 

To translate each online Help project, follow the instructions in this section. 

 To translate and compile an existing RoboHelp project: 

1 Open the project: 

a Download the zipped file to your local system and extract or uncompress the contents to a 
destination folder. 

b Access the destination folder, locate the RoboHelp project file (*.xpj), and double-click on it. 
The project opens in the Project Manager view, which lists all topics alphabetically. 

You will probably want to work in the TOC view, which displays a list of books and related 
topics. To switch to the TOC view, click TOC in the lower left pane. To open a book, click on 
the plus sign (+) on its left or simply double-click the book title. All sub-books/topics in that 
book are displayed. To open a sub-book/topic, double-click on the book/topic title. 
Clicking on any topic displays it in the WYSIWYG view (right pane). 

2 Translate all required components. 

The components include: 

 All book titles and topic titles. 

 All visible text on the right pane (body text). 

 All navigational components on the top navigation frame. The navigational components can 
be accessed through the project skin file. 

 All graphic tooltips. 

 All glossary entries. 

 All index entries. 

 The project title. 

 The footer text. The footer text can be accessed through the footer template file (Footer.htt). 

 The text on the Related Topics button and all topics referenced therein. 

Caution: Be careful not to change or remove bookmarks and comments; without them, 
you cannot install the Help on the Ensim Pro system. 

 

Generating the output for each level 

Each Help project contains SSL (single-source layouts) that make it easy to generate different Help 
systems from the same project. Provided that conditional text settings have not been changed 
during the translation, you should not need to modify the layouts. All you need to do is generate the 
output as described in this section. 
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 To generate output for service provider, reseller, organization, and user level Help: 

1 Save the project. 

2 On the File menu, click Batch Generate. 

3 On the Batch Generate form, select the layouts you want to generate. Click the check box left of 
the Layout Name column to select each layout. To generate all four levels, select the following 
layouts: 

For General Help 

 isp_admin_trinity 

 org_admin_trinity 

 res_admin_trinity 

 usr_admin_trinity 

For DNS Help 

 isp_dns_trinity 

 org_dns_trinity 

 res_dns_trinity 

For Windows Web Hosting Help 

 isp_trinity 

 org_trinity 

 res_trinity 

 usr_trinity 

4 Click Generate. RoboHelp generates each layout. When the layout has been generated, 
Generated appears in the Status column. 

5 When the files have been generated, click Close at the bottom of the Batch Generate window. 

The new output appears in the <proj_dir>\!SSL!\Trinity folder, where <proj_dir> is the path 
where the RoboHelp source files are located. The output is placed in separate folders that match 
the layout names in the previous step. 

Note: To view the output folder path for each layout, under the Project tab, right-click the 
layout name and select Properties; this opens the properties dialog box for the 
selected layout. The Select Output Folder and Start Page text box displays the output 
folder path. 

 

Installing the translated Help files 

After you have translated and generated the online Help, you need to install the Help onto the 
Ensim Pro server. 

 

Installing the general Help 

To install the general Help onto the Ensim Pro server, follow the instructions in this section. 
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 To install the general Help: 

1 Go to the directory $Ensim Pro Install Dir$\cp\admin\help. If you installed Ensim Pro under 
C:\Program Files, the path for the cp\admin directory will be  
C:\Program Files\Ensim\WEBppliance\cp\admin\help. 

2 If you had already installed the general Help (the default English version), you will find a folder 
named help under cp\admin (that is, cp\admin\help). 

If not, create a folder named help under the cp\admin directory and create the following four 
subfolders within the help folder: ispadmin, siteadmin, resadmin, useradmin 

Example: 

cp\admin\help          directory:      ispadmin, siteadmin, resadmin, useradmin 

3 Create your language specific directory inside each of these four subfolders:  
ispadmin, siteadmin, resadmin, useradmin. The names for the language specific directories are 
specified in the language and directory names table ("Languages and directory names" on page 
12). 

For example, for Chinese (People's Republic of China), the directory name is zh-CN. 
Therefore, you will create four language-specific directories under each of these four subfolders: 

 cp\admin\help\ispadmin\zh-CN 

 cp\admin\help\siteadmin\zh-CN 

 cp\admin\help\resadmin\zh-CN 

 cp\admin\help\useradmin\zh-CN 

4 Go to the <proj_dir>\!SSL!\Trinity folder which was created during the generation of the Help 
output for each level (where <proj_dir> is the path where the RoboHelp source files are located). 

You will find four subdirectories in this directory. 

 ispadmin 

 siteadmin 

 resadmin 

 useradmin 

5 Copy the contents of: 

 ispadmin to cp\admin\help\ispadmin\zh-CN 

 siteadmin to cp\admin\help\siteadmin\zh-CN 

 resadmin to cp\admin\help\resadmin\zh-CN 

 useradmin to cp\admin\help\useradmin\zh-CN 

6 Access and use the Ensim Pro general online Help. 
 

Installing DNS Help and Windows Web Hosting Help 

To install DNS Help and Windows Web Hosting Help onto the Ensim Pro server, follow the 
instructions in this section. 
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 To install DNS Help and Windows Web Hosting Help: 

1 Go to the directory $Ensim Pro Install Dir$\cp\admin\help. If you installed Ensim Pro under 
C:\Program Files, the path for the cp\admin directory will be  
C:\Program Files\Ensim\WEBppliance\cp\admin\help. 

2 If not present, create the following folder structure under the following for both DNS and 
Windows Web Hosting: 

 ispadmin\<language_directory>\Services\<ServiceName>\<version number> 

 siteadmin\<language_directory>\Services\<ServiceName>\<version number> 

 resadmin\<language_directory>\Services\<ServiceName>\<version number> 

 useradmin\<language_directory>\Services\<ServiceName>\<version number> 

where: 

<language_directory> refers to the directory name for the selected language. For the 
complete list of languages and corresponding directory names, see the language and 
directory names table ("Languages and directory names" on page 12). 

For example, for the Chinese (People's Republic of China) language, the directory name is 
zh-CN, so you would replace <language directory name> with zh-CN. 

<ServiceName> refers to one of the following: 

 DNSService - DNS 

 WebHosting - Windows Web Hosting 

<version number> refers to the current version number (dot release: x.x.x). For example, 
10.0.0. 

3 Go to the <proj_dir>\!SSL!\Trinity folder which was created during the generation of the Help 
output for each level (where <proj_dir> is the path where the RoboHelp source files are located). 

You will find four subdirectories within this directory: 

 ispadmin 

 siteadmin 

 resadmin 

 useradmin 

Note: DNS has only three subdirectories: isp_dns_trinity, org_dns_trinity, and 
res_dns_trinity. 

4 Copy the contents of the folders as listed below: 

 ispadmin to ispadmin\<language directory name>\Services\<ServiceName>\<version 
number>\ 

 siteadmin to siteadmin\<language directory name>\Services\<ServiceName>\<version 
number>\ 

 resadmin to resadmin\<language directory name>\Services\<ServiceName>\<version 
number>\ 

 useradmin to useradmin\<language directory name>\Services\<ServiceName>\<version 
number>\ 
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5 Unzip epw_services_xml.zip from the CD-ROM to  
C:\Program Files\Ensim\WEBppliance\cp\admin. Click Yes if prompted to overwrite 
existing files. 

6 Open a command prompt and cd to  
C:\Program Files\Ensim\WEBppliance\cp\admin\bin. 

7 If not present, download the ServiceHelpMaker.exe from the CD-ROM and run it with the 
following options. This will create links to the DNS Help and Windows Web Hosting Help in 
the general Help. 

ServiceHelpMaker.exe “<ServiceName>” <Version> “<Physical Directory of the CP>” None 
<Installation Options> 

where: 

<ServiceName> refers to: 

o DNSService - DNS 

o WebHosting - Windows Web Hosting 

<Version> refers to the current version number of DNSService or Windows Web Hosting. 
For example, 10.0.0. 

<Physical Directory of the CP> refers to the default directory path,  
C:\Program Files\Ensim\WEBppliance\cp\admin. 

<Installation Options> refers to the following options: 

o C - create links to the <ServiceName> Help in the general Help 

o D - delete links to the <ServiceName> Help in the general Help 
(user either C or D, but not both) 

Example: 

ServiceHelpMaker.exe "DNSService" 10.0.0 "C:\Program 
Files\Ensim\WEBppliance\cp\admin" None C 

Note: Run the ServiceHelpMaker.exe for both DNS and Windows Web Hosting. 

8 Using a text editor such as Notepad, manually edit all instances of the web.config file at all 
levels with these instructions: 

a Go to C:\Program Files\Ensim\WEBppliance\cp\admin\ispadmin\web.config; look for 
the variable helpFilePath under the tag /configuration/ensim.wvh/pageFormat/menu and 
change it to "help/ispadmin/<language directory name>". Also change the variable 
helpFilePathRes to "help/resadmin/<language directory name>", where 
<language_directory> refers to the directory name for the selected language. For the 
complete list of languages and corresponding directory names, see the language and 
directory name table ("Languages and directory names" on page 12). 

b Go to C:\Program Files\Ensim\WEBppliance\cp\admin\siteadmin\web.config; look 
for the variable helpFilePath under the tag /configuration/ensim.wvh/pageFormat/menu 
and change it to "help/siteadmin/<language directory name>". 

c Go to C:\Program Files\Ensim\WEBppliance\cp\admin\useradmin\web.config; look 
for the variable helpFilePath under the tag /configuration/ensim.wvh/pageFormat/menu 
and change it to "help/useradmin/<language directory name>". 
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d Go to the following locations and edit each instance of the web.config file to change the 
variable helpFilePath as described in Step a, Step b, and Step c above. Also change the 
variable helpIDPath to "help/<level name>/<language directory 
name>/Services/<service>/<version>/helpData.xml", where <level name> is one of ispadmin, 
resadmin, siteadmin, or useradmin. 

Important: Do not change the helpIDPath variable if the location it points to is the same 
as the location in which the web.config file is present.  
For example, if the web.config file is located in C:\Program Files\Ensim\ 
WEBppliance\cp\admin\siteadmin\services\WebHosting and  
helpIDPath="/siteadmin/services/webhosting/helpData.xml", then do not 
change the helpIDPath variable. 

web.config under ispadmin directory 

 C:\Program Files\Ensim\WEBppliance\cp\admin\ispadmin\ 
serviceComponents\frontpage\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\ispadmin\ 
serviceComponents\msdns\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\ispadmin\ 
serviceComponents\w3svc\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\ispadmin\services\ 
WebHosting\web.config 

web.config under siteadmin directory 

 C:\Program Files\Ensim\WEBppliance\cp\admin\siteadmin\ 
serviceComponents\filemanager\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\siteadmin\ 
serviceComponents\frontpage\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\siteadmin\ 
serviceComponents\mail\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\siteadmin\ 
serviceComponents\msde\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\siteadmin\ 
serviceComponents\msdns\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\siteadmin\ 
serviceComponents\msftp\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\siteadmin\ 
serviceComponents\mysql\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\siteadmin\ 
serviceComponents\odbc\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\siteadmin\ 
serviceComponents\powertools\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\siteadmin\ 
serviceComponents\Urchin\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\siteadmin\ 
serviceComponents\w3svc\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\siteadmin\ 
serviceComponents\webalizer\web.config 
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 C:\Program Files\Ensim\WEBppliance\cp\admin\siteadmin\services\ 
WebHosting\web.config 

web.config under useradmin directory 

 C:\Program Files\Ensim\WEBppliance\cp\admin\useradmin\ 
ServiceComponents\frontpage\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\useradmin\ 
ServiceComponents\mail\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\useradmin\ 
ServiceComponents\msftp\web.config 

 C:\Program Files\Ensim\WEBppliance\cp\admin\useradmin\ 
ServiceComponents\w3svc\web.config 

9 Access and use the Ensim Pro service-specific Help. 
 

Languages and directory names 

The following table provides a complete list of languages and corresponding directory names. 

Table 2.  Complete list of languages and directory names 

Language Directory name 
<language_directory> 

Afrikaans af 

Afrikaans (South Africa) af-ZA 

Albanian sq 

Albanian (Albania) sq-AL 

Arabic ar 

Arabic (Algeria) ar-DZ 

Arabic (Bahrain) ar-BH 

Arabic (Egypt) ar-EG 

Arabic (Iraq) ar-IQ 

Arabic (Jordan) ar-JO 

Arabic (Kuwait) ar-KW 

Arabic (Lebanon) ar-LB 

Arabic (Libya) ar-LY 

Arabic (Morocco) ar-MA 

Arabic (Oman) ar-OM 

Arabic (Qatar) ar-QA 

Arabic (Saudi Arabia) ar-SA 
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Table 2.  Complete list of languages and directory names 

Language Directory name 
<language_directory> 

Arabic (Syria) ar-SY 

Arabic (Tunisia) ar-TN 

Arabic (U.A.E.) ar-AE 

Arabic (Yemen) ar-YE 

Armenian hy 

Armenian (Armenia) hy-AM 

Azeri az 

Azeri (Cyrillic) (Azerbaijan) az-AZ-Cyrl 

Azeri (Latin) (Azerbaijan) az-AZ-Latn 

Basque eu 

Basque (Basque) eu-ES 

Belarusian be 

Belarusian (Belarus) be-BY 

Bulgarian bg 

Bulgarian (Bulgaria) bg-BG 

Catalan ca 

Catalan (Catalan) ca-ES 

Chinese (Hong Kong S.A.R.) zh-HK 

Chinese (Macau S.A.R.) zh-MO 

Chinese (People's Republic of China) zh-CN 

Chinese (Simplified) zh-CHS 

Chinese (Singapore) zh-SG 

Chinese (Taiwan) zh-TW 

Chinese (Traditional) zh-CHT 

Croatian hr 

Croatian (Croatia) hr-HR 

Czech cs 

Czech (Czech Republic) cs-CZ 

Danish da 

Danish (Denmark) da-DK 
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Table 2.  Complete list of languages and directory names 

Language Directory name 
<language_directory> 

Divehi div 

Divehi (Maldives) div-MV 

Dutch nl 

Dutch (Belgium) nl-BE 

Dutch (Netherlands) nl-NL 

English en 

English (Australia) en-AU 

English (Belize) en-BZ 

English (Canada) en-CA 

English (Caribbean) en-CB 

English (Ireland) en-IE 

English (Jamaica) en-JM 

English (New Zealand) en-NZ 

English (Republic of the Philippines) en-PH 

English (South Africa) en-ZA 

English (Trinidad and Tobago) en-TT 

English (United Kingdom) en-GB 

English (United States) en-US 

English (Zimbabwe) en-ZW 

Estonian et 

Estonian (Estonia) et-EE 

Faroese fo 

Faroese (Faroe Islands) fo-FO 

Farsi fa 

Farsi (Iran) fa-IR 

Finnish fi 

Finnish (Finland) fi-FI 

French fr 

French (Belgium) fr-BE 

French (Canada) fr-CA 

French (France) fr-FR 
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Table 2.  Complete list of languages and directory names 

Language Directory name 
<language_directory> 

French (Luxembourg) fr-LU 

French (Principality of Monaco) fr-MC 

French (Switzerland) fr-CH 

FYRO Macedonian mk 

FYRO Macedonian (Former Yugoslav Republic of Macedonia) mk-MK 

Galician gl 

Galician (Galician) gl-ES 

Georgian ka 

Georgian (Georgia) ka-GE 

German de 

German (Austria) de-AT 

German (Germany) de-DE 

German (Liechtenstein) de-LI 

German (Luxembourg) de-LU 

German (Switzerland) de-CH 

Greek el 

Greek (Greece) el-GR 

Gujarati gu 

Gujarati (India) gu-IN 

Hebrew he 

Hebrew (Israel) he-IL 

Hindi hi 

Hindi (India) hi-IN 

Hungarian hu 

Hungarian (Hungary) hu-HU 

Icelandic is 

Icelandic (Iceland) is-IS 

Indonesian id 

Indonesian (Indonesia) id-ID 

Invariant Language (Invariant Country)  

Italian it 
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Table 2.  Complete list of languages and directory names 

Language Directory name 
<language_directory> 

Italian (Italy) it-IT 

Italian (Switzerland) it-CH 

Japanese ja 

Japanese (Japan) ja-JP 

Kannada kn 

Kannada (India) kn-IN 

Kazakh kk 

Kazakh (Kazakhstan) kk-KZ 

Konkani kok 

Konkani (India) kok-IN 

Korean ko 

Korean (Korea) ko-KR 

Kyrgyz ky 

Kyrgyz (Kyrgyzstan) ky-KZ 

Latvian lv 

Latvian (Latvia) lv-LV 

Lithuanian lt 

Lithuanian (Lithuania) lt-LT 

Malay ms 

Malay (Brunei Darussalam) ms-BN 

Malay (Malaysia) ms-MY 

Marathi mr 

Marathi (India) mr-IN 

Mongolian mn 

Mongolian (Mongolia) mn-MN 

Norwegian no 

Norwegian (Bokmål) (Norway) nb-NO 

Norwegian (Nynorsk) (Norway) nn-NO 

Polish pl 

Polish (Poland) pl-PL 

Portuguese pt 
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Table 2.  Complete list of languages and directory names 

Language Directory name 
<language_directory> 

Portuguese (Brazil) pt-BR 

Portuguese (Portugal) pt-PT 

Punjabi pa 

Punjabi (India) pa-IN 

Romanian ro 

Romanian (Romania) ro-RO 

Russian ru 

Russian (Russia) ru-RU 

Sanskrit sa 

Sanskrit (India) sa-IN 

Serbian (Cyrillic) (Serbia) sr-SP-Cyrl 

Serbian (Latin) (Serbia) sr-SP-Latn 

Slovak sk 

Slovak (Slovakia) sk-SK 

Slovenian sl 

Slovenian (Slovenia) sl-SI 

Spanish es 

Spanish (Argentina) es-AR 

Spanish (Bolivia) es-BO 

Spanish (Chile) es-CL 

Spanish (Colombia) es-CO 

Spanish (Costa Rica) es-CR 

Spanish (Dominican Republic) es-DO 

Spanish (Ecuador) es-EC 

Spanish (El Salvador) es-SV 

Spanish (Guatemala) es-GT 

Spanish (Honduras) es-HN 

Spanish (Mexico) es-MX 

Spanish (Nicaragua) es-NI 

Spanish (Panama) es-PA 

Spanish (Paraguay) es-PY 
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Table 2.  Complete list of languages and directory names 

Language Directory name 
<language_directory> 

Spanish (Peru) es-PE 

Spanish (Puerto Rico) es-PR 

Spanish (Spain) es-ES 

Spanish (Uruguay) es-UY 

Spanish (Venezuela) es-VE 

Syriac syr 

Syriac (Syria) syr-SY 

Swahili sw 

Swahili (Kenya) sw-KE 

Swedish sv 

Swedish (Finland) sv-FI 

Swedish (Sweden) sv-SE 

Tamil ta 

Tamil (India) ta-IN 

Tatar tt 

Tatar (Russia) tt-RU 

Telugu te 

Telugu (India) te-IN 

Thai th 

Thai (Thailand) th-TH 

Turkish tr 

Turkish (Turkey) tr-TR 

Ukrainian uk 

Ukrainian (Ukraine) uk-UA 

Urdu ur 

Urdu (Islamic Republic of Pakistan) ur-PK 

Uzbek uz 

Uzbek (Cyrillic) (Uzbekistan) uz-UZ-Cyrl 

Uzbek (Latin) (Uzbekistan) uz-UZ-Latn 

Vietnamese vi 

Vietnamese (Viet Nam) vi-VN 
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Support and feedback 

For Ensim online support or feedback, use the following links: 

• http://support.ensim.com to create an Ensim Support account and access other documentation. 

• https://onlinesupport.ensim.com to log in to Ensim Support using an existing account 

• http://onlinesupport.ensim.com/kb_search_sln.asp to search the knowledge base 

• http://www.ensim.com/about/feedback.asp to provide feedback to Ensim 

Note: All customers receive passwords that allow access to the Ensim Support site. If you 
do not have a password, contact your organization’s liaison to Ensim. 

 

Legal and copyright notice 

This document contains information proprietary to Ensim Corporation and its receipt or possession 
does not convey any rights to reproduce, disclose, manufacture, or sell anything it might describe. 
Reproduction, disclosure, or use without Ensim’s specific written authorization is strictly forbidden. 
Ensim Corporation makes no representations or warranties with respect to the contents or use of 
this document. It also reserves the right to revise this publication and make changes to the content 
at any time, without the obligation to notify any person or entity of such revisions or changes.  

Further, Ensim Corporation assumes no responsibility or liability for any errors or inaccuracies, 
makes no warranty of any kind (express, implied or statutory) with respect to the contents or use of 
the information, and expressly disclaims any and all warranties of merchantability, fitness for 
particular purposes, and non-infringement of third party rights.  

Ensim and the Ensim logo are registered trademarks of Ensim Corporation. All other trademarks are 
the property of their respective owners. 

© 2006 Ensim Corporation. All rights reserved.  

 

CORPORATE HEADQUARTERS 

Ensim Corporation 
1366 Borregas Avenue 
Sunnyvale, California  94089 
(408) 745-3300 

www.ensim.com 
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